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Chapter 525

Equivalence Tests for the
Ratio of Two Means in a
2x2 Cross-Over Design
(Log-Normal Data)
Introduction
This procedure calculates power and sample size of statistical tests of equivalence of the means from a 2x2 crossover design which is analyzed with a t-test. This routine deals with the case in which the statistical hypotheses are
expressed in terms mean of ratios rather than mean differences.
The details of testing the equivalence of two treatments using data from a 2x2 cross-over design are given in another
chapter and will not be repeated here. If the logarithms of the responses can be assumed to follow the normal
distribution, hypotheses about the equivalence of two means stated in terms of the ratio can be transformed into
hypotheses about the difference. The details of this analysis are given in Julious (2004). They will only be
summarized here.

Equivalence Testing Using Ratios
PASS follows the two one-sided tests approach described by Schuirmann (1987) and Phillips (1990). It will be
convenient to adopt the following specialized notation for the discussion of these tests.
Parameter
𝜇𝜇𝑇𝑇

PASS Input/Output Interpretation
Not used
Treatment mean. This is the treatment mean.

𝑅𝑅𝐿𝐿 , 𝑅𝑅𝑈𝑈

𝜇𝜇𝑅𝑅

Not used

Reference mean. This is the mean of a reference population.

RL, RU

Equivalence Limits. These limits define an interval of the ratio of the
means in which their difference is so small that it may be ignored.

𝜙𝜙

R1

Actual ratio. This is the value of 𝜙𝜙 = 𝜇𝜇𝑇𝑇 /𝜇𝜇𝑅𝑅 at which the power is
calculated.

Note that the actual values of 𝜇𝜇𝑇𝑇 and 𝜇𝜇𝑅𝑅 are not needed. Only the ratio of these values is needed for power and
sample size calculations.
With 𝑅𝑅𝐿𝐿 < 1 and 𝑅𝑅𝑈𝑈 > 1, the null hypothesis of non-equivalence is
The alternative hypothesis of equivalence is

𝐻𝐻0 : 𝜙𝜙 ≤ 𝑅𝑅𝐿𝐿 or 𝜙𝜙 ≥ 𝑅𝑅𝑈𝑈 .
𝐻𝐻1 : 𝑅𝑅𝐿𝐿 < 𝜙𝜙 < 𝑅𝑅𝑈𝑈 .
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Log-Transformation
In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of
differences. This is because ratios can be interpreted as scale-less percentages, but differences must be interpreted
as actual amounts in their original scale. Hence, it has become a common practice to take the following steps in
hypothesis testing.
1. State the statistical hypotheses in terms of ratios.
2. Transform these into hypotheses about differences by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in terms of the ratio.
The details of step 2 for the alternative hypothesis are as follows:
𝜇𝜇𝑇𝑇
< 𝑅𝑅𝑈𝑈 ⇒ 𝐻𝐻1 : ln(𝑅𝑅𝐿𝐿 ) < ln(𝜇𝜇𝑇𝑇 ) − ln(𝜇𝜇𝑅𝑅 ) < ln(𝑅𝑅𝑈𝑈 )
𝐻𝐻1 : 𝑅𝑅𝐿𝐿 < 𝜙𝜙 < 𝑅𝑅𝑈𝑈 ⇒ 𝐻𝐻1 : 𝑅𝑅𝐿𝐿 <
𝜇𝜇𝑅𝑅

Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the
difference of two means on the logged scale.

When performing an equivalence test on the difference between means, the usual procedure is to set the
equivalence limits symmetrically above and below zero. Thus the equivalence limits will be plus or minus an
appropriate amount. The common practice is to do the same when the data are being analyzed on the log scale.
However, when symmetric limits are set on the log scale, they do not translate to symmetric limits on the original
scale. Instead, they translate to limits that are the inverses of each other.
Perhaps these concepts can best be understood by considering an example. Suppose the researchers have
determined that the lower equivalence limit should be 80% on the original scale. Since they are planning to use a
log scale for their analysis, they transform this limit to the log scale by taking the logarithm of 0.80. The result is 0.223144. Wanting symmetric limits, they set the upper equivalence limit to 0.223144. Exponentiating this value,
they find that exp(0.223144) = 1.25. Note that 1/(0.80) = 1.25. Thus, the limits on the original scale are 80% and
125%, not 80% and 120%.
Using this procedure, appropriate equivalence limits for the ratio of two means can be easily determined. Here are
a few sets of equivalence limits.

Specified
Percent
Change
-25%
+25%
-20%
+20%
-10%
+10%

Lower
Limit
Original
Scale
75.0%
80.0%
80.0%
83.3%
90.0%
90.9%

Upper
Limit
Original
Scale
133.3%
125.0%
125.0%
120.0%
111.1%
110.0%

Lower
Limit
Log
Scale
-0.287682
-0.223144
-0.223144
-0.182322
-0.105361
-0.095310

Upper
Limit
Log
Scale
0.287682
0.223144
0.223144
0.182322
0.105361
0.095310

Note that negative percent-change values specify the lower limit first, while positive percent-change values
specify the upper limit first. After the first limit is found, the other limit is calculated as its inverse.
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Coefficient of Variation
The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter is used to
represent the variation in the data because of a unique relationship that it has in the case of log-normal data.
Suppose the variable X is the logarithm of the original variable Y. That is, X = ln(Y) and Y = exp(X). Label the
mean and variance of X as 𝜇𝜇𝑋𝑋 and 𝜎𝜎𝑋𝑋2 , respectively. Similarly, label the mean and variance of Y as 𝜇𝜇𝑌𝑌 and 𝜎𝜎𝑌𝑌2 ,
respectively. If X is normally distributed, then Y is log-normally distributed. Julious (2004) presents the following
well-known relationships between these two variables
𝜇𝜇𝑌𝑌 =

𝜎𝜎 2
𝜇𝜇𝑋𝑋 + 𝑋𝑋
2
𝑒𝑒

2

𝜎𝜎𝑌𝑌2 = 𝜇𝜇𝑌𝑌2 �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1�

From this relationship, the coefficient of variation of Y can be found to be
𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌 =

2

�𝜇𝜇𝑌𝑌2 �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1�
𝜇𝜇𝑌𝑌

= �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1
2

= �𝑒𝑒 𝜎𝜎𝑊𝑊 − 1
2

2
is the within mean square error from the analysis of variance of the logged data. Solving this
where 𝜎𝜎𝑊𝑊
relationship for 𝜎𝜎𝑋𝑋2 , the standard deviation of X can be stated in terms of the coefficient of variation of Y as

Similarly, the mean of X is

𝜎𝜎𝑋𝑋 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1)

𝜇𝜇𝑋𝑋 = ln �

𝜇𝜇𝑌𝑌

�𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1

�

Thus, the hypotheses can be stated in the original (Y) scale and then power can be analyzed in the transformed
(X) scale.

Power Calculation
As is shown above, the hypotheses can be stated in the original (Y) scale using ratios or the logged (X) scale
using differences. Either way, the power and sample size calculations are made using the formulas for testing the
equivalence of the difference in two means. These formulas are presented in another chapter and are not
duplicated here.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power for a power analysis or Sample Size for sample size determination.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
unequal means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of unequal
means when in fact the means are unequal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Total Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study (total subjects
in both sequences). This value must be an integer greater than one.
When N is even, it is split evenly between the two sequences. When N is odd, the first sequence has one more
subject than the second sequence.
Note that you may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.
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Effect Size – Equivalence Limits
RU (Upper Equivalence Limit)
Enter the upper equivalence limit for the ratio of the two means. When the ratio of the means is between this value
and RL, the two means are said to be equivalent. The value must be greater than one. A popular choice is 1.25.
Note that this value is not a percentage.
If you enter 1/RL, then 1/RL will be calculated and used here. This choice is commonly used because RL and
1/RL give limits that are of equal magnitude on the log scale.
RL (Lower Equivalence Limit)
Enter the lower equivalence limit for the ratio of the two means. When the ratio of the means is between this value
and RU, the two means are said to be equivalent. The value must be less than one. A popular choice is 0.80. Note
that this value is not a percentage.
If you enter 1/RU, then 1/RU will be calculated and used here. This choice is commonly used because RU and
1/RU give limits that are of equal magnitude on the log scale.

Effect Size – True Ratio
R1 (Actual Ratio)
This is the value of the ratio of the two means at which the power is to be calculated. Usually, the ratio will be
assumed to be one. However, some authors recommend calculating the power using a ratio of 1.05 since this will
require a larger sample size.

Effect Size – Coefficient of Variation
COV (Coefficient of Variation)
The coefficient of variation is the ratio of the standard deviation and the mean (SD/Mean). It is used to specify the
variability (standard deviation). Note that this COV is defined on the original (not logarithmic) scale. This value
must be determined from past experience or from a pilot study.
To be clear, consider the following definition. Suppose data on a response variable Y are collected. This
procedure assumes that the values of X = Ln(Y) are analyzed using an appropriate ANOVA procedure. Thus,
there are two sets of means and standard deviations: those of X labelled MX and SX and those of Y labelled MY
and SY. The COV entered here is the COV of Y = SY/MY. For log-normal data, the following relationship exists:
COV(Y) = SQR(Exp(SX*SX)-1) where SX is the square root of the within mean square error in the ANOVA
table of the log-transformed values.
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Example 1 – Finding Power
A company has opened a new manufacturing plant and wants to show that the drug produced in the new plant is
equivalent to that produced in an older plant. A cross-over design will be used to test the equivalence of drugs
produced at the two plants.
Researchers have decided to set the equivalence limits for the ratio at 0.90 and 1.111 (note that 1.111 = 1/0.90).
Past experience leads the researchers to set the COV to 0.50. The significance level is 0.05. The power will be
computed assuming that the true ratio is one. Sample sizes between 50 and 550 will be included in the analysis.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
N (Total Sample Size)............................. 50 to 550 by 100
RU (Upper Equivalence Limit) ................ 1/RL
RL (Lower Equivalence Limit) ................. 0.90
R1 (Actual Ratio) .................................... 1.0
COV (Coefficient of Variation) ................ 0.50

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Equivalence ────────────────────────────────────────────
R = Treatment Mean / Reference Mean
Hypotheses: H0: R ≤ EL or R ≥ EU vs. H1: RL < R < RU

Power
0.00001
0.21897
0.60022
0.80639
0.91006
0.95957

Total
Sample
Size
N
50
150
250
350
450
550

Lower
Equiv
Limit
RL
0.900
0.900
0.900
0.900
0.900
0.900

Upper
Equiv
Limit
RU
1.111
1.111
1.111
1.111
1.111
1.111

Actual
Ratio
R1
1.000
1.000
1.000
1.000
1.000
1.000

COV
0.500
0.500
0.500
0.500
0.500
0.500

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

Beta
0.99999
0.78103
0.39978
0.19361
0.08994
0.04043

Report Definitions
Power is the probability of rejecting non-equivalence when the means are equivalent.
N is the total number of subjects split between both sequences.
RL & RU are the lower and upper equivalence limits, respectively. Ratios between these limits are equivalent.
R1 is the ratio of the means at which the power is computed.
COV is the coefficient of variation on the original scale.
Alpha is the probability of rejecting non-equivalence when the means are non-equivalent.
Beta is the probability of accepting non-equivalence when the means are equivalent.
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Summary Statements ─────────────────────────────────────────────────────────
In an equivalence test of means using two one-sided tests on data from a two-period cross-over
design, a total sample size of 50 achieves 0% power at a 5% significance level when the actual
ratio of the means is 1.000, the coefficient of variation on the original, unlogged scale is
0.500, and the equivalence limits of the mean ratio are 0.900 and 1.111.

This report shows the power for the indicated scenarios. Note that if they want 90% power, they will require a
sample of around 450 subjects.

Plots Section

This plot shows the power versus the sample size.
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Example 2 – Validation using Julious (2004)
Julious (2004) page 1963 presents a table of sample sizes for various parameter values. The power is 0.90 and the
significance level is 0.05. The COV is set to 0.25, the ‘level of bioequivalence’ is set to 10%, 15%, 20%, and
25%, and the true ratio is set to 1.00, the necessary sample sizes are 120, 52, 28, and 18. Note that the level of
bioequivalence as defined in Julious (2004) is equal to 1 – RL.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
RU (Upper Equivalence Limit) ................ 1/RL
RL (Lower Equivalence Limit) ................. 0.90 0.85 0.80 0.75
R1 (Actual Ratio) .................................... 1.0
COV (Coefficient of Variation) ................ 0.25

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Equivalence ────────────────────────────────────────────
R = Treatment Mean / Reference Mean
Hypotheses: H0: R ≤ EL or R ≥ EU vs. H1: RL < R < RU

Power
0.91211
0.90226
0.90601
0.90119

Total
Sample
Size
N
18
28
52
120

Lower
Equiv
Limit
RL
0.750
0.800
0.850
0.900

Upper
Equiv
Limit
RU
1.333
1.250
1.176
1.111

Actual
Ratio
R1
1.000
1.000
1.000
1.000

COV
0.250
0.250
0.250
0.250

Alpha
0.050
0.050
0.050
0.050

Beta
0.08789
0.09774
0.09399
0.09881

Note that PASS obtains the same samples sizes as Julious (2004).
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